
GASWorkS™10.0 Example Calibration

Summary

In this example, an existing model will be used to
demonstrate the process of calibrating a model so
that the model results match the field measured
values.

For calibration we will use a “measured” field
value of 6.4 Psi for Node 120, 8.4 Psi for Node 40,
a supply pressure at Node CIG TAP of 19.2 Psi,
and a total flow into the system of 8.5 Mcfh.

Steps

The following assumes that GASWorkS has already
been started. If a model is already open, close it by
selecting the Close menu item from the File menu
list. Use the following procedure to work this
example...

1) Open The Existing Model

! From the File menu list, select the Open menu item. The File Selection screen will be displayed. Use the
Drives and Directories lists to navigate to the directory containing the desired file - weston example.hdr.
Select the file, then select the Continue command button.

! The Graphic Data Interface (GDI) Window will be displayed. Note - If the GDI Window is not
automatically displayed, select the View/Edit menu item from the Graphics menu list to display the GDI
Window.

! Resize the GDI Window using the Maximize GDI Window icon from the GDI Window Controls
Toolbar.

! Zoom the GDI Image to fill the GDI Display using the Zoom To Fit icon from the lower-left
corner of the GDI Window.
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2) Save The Model To A New Name

Before making changes to the model, let’s save it to a new name.

! From the File menu list, select the Save As menu item. The File Selection screen will be displayed.
Enter a new Filename for the model, then select the Continue command button.

3) Reset The Pipe Efficiencies

Before starting a calibration, it is a good idea to reset all of the pipe efficiencies to 1.0 using the Mass Update
routine.

! From the Edit menu list, select the Mass Update menu item. The Mass Update Specifications
screen will be displayed. Set the following values:

Set = Pipe Efficiency
Equal To = 1.0
Apply To All Records = Select

! Select the Update command button to make the changes. A message will be displayed reporting
the number of records updated. Select the OK command button to clear the message. 

! On the Mass Update Specifications screen, select the Close command button.

4) Determine The Design Factor

We need to cause the total flow in-to the system to match the field reported value. To do that we will adjust
the Design Factor parameter. The Design Factor adjusts the system loads up or down without changing the
actual load data values. To determine the appropriate value for the Design Factor, let’s first find the total
flow in-to the system for a Design Factor equal to 1.0, then we will calculate the Design Factor value that
we need to match the field value.

Solve The Model At A Design Factor Of 1.0 -

! Select the Solve icon from the lower-right corner of the GDI Window. The Solution
Data screen will be displayed. 

! On the Solution Data tab, set the following values:

Design Factor = 1.0
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! Review the other solution parameters. Select the Solve command button to solve the model. The
Solution Log will be displayed. When the solution is complete, review the results. Select the Close
command button to close the log.

Determine The Flow Rate At A Design Factor Of 1.0 -

! From the Report menu list, select the System Summary menu item.

! The System Summary Report Options screen will be displayed. Select (check) the Supply Nodes
Summary option, and unselect (uncheck) all the other options. Select the Continue command button.

! The System Summary Report will be displayed. Note the total flow rate being supplied by Node
CIG TAP. It should be about 5.7 Mcfh. Select the Close command button to close the report screen.

Calculate The Required Design Factor -

! Calculate the Design Factor by dividing the measured flow (8.5 Mcfh) by the current total system
flow (5.7 Mcfh). 

Required Design Factor = 8.5 / 5.7 = 1.5

! The required Design Factor should be about 1.5.

5) Set The Supply Pressure

We need to set the pressure at the supply point to the field recorded value before we start checking the other
system pressures. To do that...

! Left-click on Node CIG TAP. Note - If you cannot select the node, use the Edit Node
Data command.

! The Node Data will be displayed in the Data Panel. In the Hydraulic Data
Items section, set the following values:

Pressure = 19.2
Pressure Units = Psi

! Select the Apply Data Values command button to save the changes.
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6) Solve The Model

Now let’s solve the model to calculate the system pressures associated with the new Design Factor and
supply pressure.

! Select the Solve icon from the GDI Window. The Solution Data screen will be
displayed.

! On the Solution Data tab, set the following value:

Design Factor = 1.5

! Review the remaining solution parameters. Select the Solve command button. The Solution Log
will be displayed.  When the solution is complete, review the results. Select the Close command
button to close the log screen.

7) Review The Results

For calibration purposes, we will use a field value of 6.4 Psig for Node 120 and 8.4 Psig for Node 40. It’s
best to start the “calibration” process by reviewing the results for the node (with a measured value) closest
to a supply point with a known value. For our example, let’s look at Node 40 first and try to get its calculated
pressure to match the field results. The current model results reflect the pressure values associated with a
hydraulic efficiency of 1.0.

! Select the Find Node icon from the Data Edit Commands Toolbar. 

! For the Node Search Method, select Node Name from the list.

! For the Node Name, type 40 and press the Enter key.

! A flag will be placed at the node location.

! Left-click on Node CIG TAP. Note - If you cannot select the node, use the Edit Node
Data command.

! The Node Data will be displayed in the Data Panel. In the Hydraulic Data
Items section, take note of the Pressure value (about 12.0 Psig). The field measured value
was 8.4 Psi. In this case, the model value is higher than the field value indicating that the
model is not predicting enough pressure drop.
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8) Adjust The Pipe Efficiency

To increase the pressure drop, let’s lower the pipe efficiencies along the flow path between the supply point
and Node 40. We will use the Trace & Update routine to make the change.

! Select the Trace & Update Data item from the GDI Command List. The Trace &
Update Data Specifications screen will be displayed. Set the following values:

Trace Style = Trace Upstream
Start Trace At = A Node
Trace Highlight Color = Red (Click in the color box. The Color Palette will be

displayed. Select Red, then select the OK command
button.) 

Set = Pipe Efficiency
Equal To = 0.8

! Select the Trace & Update command button.

! For the Starting Node, select Node 40 (the flagged node).

! The pipes along the trace route will be highlighted in the selected color and a message will be
displayed. Select the Yes command button to make the change.

! A message will be displayed reporting the number of records that were updated. Select the OK
command button to clear the message.

9) Resolve The Model

! Select the Quick Solve icon from the lower-right corner of the GDI Window. The model results
will be recalculated. A message will appear only if an error occurs during the Solution process.
When the solution is complete, the new model results will be displayed.

10) Review The Results

Check the new pressure value for Node 40. If the new value is less than the field value, the pressure drop is
now too large, meaning that our pipe efficiency value is too small - increase the pipe efficiency to increase
the pressure value. If the new value is higher than the field value, the pressure drop is now too small meaning
that our pipe efficiency value is too large - decrease the pipe efficiency to decrease the pressure value.
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Continue the process of adjusting the pipe efficiency, solving the model, and reviewing the results until the
model and field pressures match within an acceptable tolerance (about 0.1 Psi for this example). The final
pipe efficiency for the pipes feeding Node 40 should be about 0.83.

Note - As an alternative to selecting Node 40 and reviewing its pressure value in the Data Panel,
you could display its pressure value on the GDI Image by using the Text Display Settings.

11) Check The Pressure At Node 120

After matching the pressure value at Node 40, check the value at Node
120. Left-click on Node 120 to display the Node Data in the Data Panel
and check the pressure value. In this case, the model value is higher than
the field value (9.3 Psig compared to 6.4 Psig). This indicates that the
pressure drop along the flow path to that point needs to be increased. We
will do that by decreasing the pipe efficiency along the flow path.

12) Adjust The Pipe Efficiency To Node 120

To increase the pressure drop along the pipes feeding Node 120, let’s lower the pipe efficiencies along the
flow path to the node, but not for the pipes that we have already adjusted.

! Select the Edit Multiple Pipes icon from the Data Edit Commands Toolbar. 

! Select the pipes along the flow path supplying Node 120 by left-clicking on the
desired pipe segments. The pipes will be highlighted when they are selected. 

! When all of the desired pipes have been selected (should be 5), right-click the mouse to
end the selection.

! The Multiple Edit Specifications screen will be displayed. On the Model Data
Items data tab, set the following values:

Set = Pipe Efficiency
Equal To = 0.8

! Select the Apply command button to make the change. A message will be
displayed reporting how many records were updated. Select the OK command
button to clear the message. 

! On the Multiple Edit Specifications screen, select the Close & Solve command
button to close the specification screen and resolve the model.
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Note - When you execute the Edit Multiple Pipes command subsequent times, and a group of pipes
was previously selected, a “Use Previous Pipe Selection...” message will be displayed, select the Yes
command button to use the previously selected pipes.

Continue to adjust the efficiencies, resolve, and review the results until the pressures are within 0.1 Psig or
so. You will find that the efficiency needs to be set relatively low (about 0.43) to make a match. This could
indicate a problem with the measurement, a problem with the data, or an operational problem with the
system.

Note- To reset the feature colors (clear the trace colors), type RESET on the GDI Command Line. To clear
the find flag (or any other flags that may be displayed), type CLEARALL on the GDI Command Line.

Notes & Considerations

! In distribution systems, generally only a few values are known compared to the total number of nodes.
Discretion and judgment often play as big of a role in the calibration as the actual field values. In other
words, do the calculated values look right? If they don’t, they probably aren’t.

! When calibrating a model, consideration should be given to the accuracy of the field measurements. For
example, were the values measured or estimated, were the values taken from a gauge that was only marked
in five pound increments, were the values taken from a chart with a fat pen, when was the instrument last
calibrated?

! Ideally, the measurements need to correspond to the exact same point in time. In other words, the
measurements need to have all been recorded at the same exact time. In distribution systems, where the flow
(and consequently the pressure) changes from hour-to-hour and day-to-day, it is very critical that the
measurements be taken at the same time.

! In this example, we assumed that the gas properties and flowing temperatures were valid for the calibration
period. It is common practice to use average values for normal design and analysis, however using average
values during the calibration process can skew and corrupt the calibration results. When performing a
calibration use the most accurate data that you have available. Obtain a gas analysis taken near the time the
calibration data was taken. Calculate the gas properties associated with the analysis and use these during the
calibration.

! Additionally, collect and use temperature values corresponding to the calibration period. Often temperature
data can be obtained from measurement data collected at meter stations. However, be careful when using
temperatures measured downstream of regulator and compressor stations. The temperature immediately
downstream of a regulator will always be lower than the average upstream and downstream gas temperatures.
Conversely, the temperature immediately downstream of compressors will almost always be higher than the
average upstream and downstream temperatures.
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! For the best results, the calibration data should correspond to a peak flow period. It is impossible to
calibrate a system that has little or no pressure drop. The higher the pressure drop across the system, the more
accurate the calibration results will be.

! Why don’t the model results match the field data values exactly? First, remember that the “model” is just
that - it is a model or a scaled representation of the actual system. There are a lot of things that are not known
very accurately about the actual system, and there are a lot of things that are not being specifically included
in the model. Items not specifically addressed by the model include such items as the affect of taps and pipe
joining methods. Unknown items include debris or liquids in the pipe, incorrect pipe sizes, incorrect or
inaccurate wall thickness values, crimped, crushed, or dented pipe segments, unusual connections, inaccurate
length values - the list goes on and on.

! Ideally, once the pipe efficiencies have been calculated along the flow paths to the known pressure
locations, an average pipe efficiency could be calculated and applied to the remaining pipes. In this case the
pipe efficiency values required to match the measured pressures at Node 120 were comparatively low, which
would generally indicate a problem with either the measured value, with the model data, or could indicate
an unusual restriction in the piping system - a partially closed valve, a pinched or partially collapsed main,
or maybe debris or liquid in the system. Averaging the pipe efficiency values found in this example would
probably not be wise.

! It is absolutely critical that a model be calibrated before it is used as the basis for any decision making. As
shown by this example, the calibration process is time consuming. However, usually the reason a model is
created is because some sort of decision needs to made. Decisions involving system modifications or system
capacity can be quite costly to implement and even more costly to fix after a bad decision has been made.
Spending a bit of time calibrating the model to ensure that it is providing accurate results, will nearly always
save you time, money, and most of all headaches later.
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